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1 INTRODUCTION

This document gives guidance on installing the Open XML to DAISY XML translator application and instructions
how to convert an Office Open XML in Word into the DAISY XML format. Using screenshots (alt text is providec
the procedure for installing and converting a document is explained for the user to have a better understanding
about the application. The wholegcedure is explained step by step. Following are the features which are
explained:

Prerequisites for installing and using the Open XML to DAISY XML Translator Application.
Features covered in Daisy translator.

Installing the Open XML to DAISY XML Trasrstgaplication.

Conversion from Office Open XML in Word to the DAISY XML Format.

Reader and Producer software.

Authoring guidelines.

Fidelity Losses.

Accessibility ribbon

11

PREREQUISITES FOR INSTALLING THE OPEN XML TO DAISY XML TRANSLATOR

Following are thererequisites for installing and converting documents:

User should have .Net Framework 3.0 installed on his machine (Windows Vista comes with .Net
Framework 3.0 we need to install it for other Operating Systems if not present).

User should have instatlesither Microsoft office 2007 or Microsoft Office 2003/Microsoft Office XP with
compatibility pack installed on his machine.

User should instaMicrosoft Office compatibility pack for Word 2007 if using either Microsoft office 2003 or
Microsoft office XRind.doc files (Office XP and 2003 file format) needs to be saved as .docx (Office 2007

file format) file before converting the document into DAISY XML format.

In Microsoft Office 2007 environment, user should have Microsoft 2007 Primary Interop Asse(Ribi)
installed on his machine.

In Microsoft Office 2003 environment, user should have Microsoft 2003 Primary Interop Assemblies (P14
installed on his machine.

User should have Java run tihéinstalled on his machine

—
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2 FEATURES COVERED

Followingfeatures are covered in Dai3yanslator:
e Dublin Core Metadata
e UID metadata
e Front matter, Book matter and rear matter mapping
e Levels and Headings
e Paragraphs
e Tables
e Lists
e b23SQa IyR b20S wSTFSNByOSa
e Emphasis and Strong
e Superscript and Subscript

e Images

e Validity

e Captions

e Page Numbers
e Sidebar

e Abbreviations and Acronyms
e Language Detection
e Block quotes

e Anchor
¢ BDO (Bidirectional object)
o Citation

e Table of Contents

e Custom styles

e MathML (Support for Mathematics)
¢ Multiple OOXML documents

e Hebper Wizard

e Full Audio Support

¢ Shapes and Objects

e Alternative Footnote

dmr SONATA
= Il! II!II

Page5



Open XML to DAISY XML Translator Instructions Guide

3 DoG/DoNGs AND FYIG

Refer Authoring Guidelines.

—-
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4 INSTALLING THE ADD-IN

This section details on the steps that should be followed while installing atinrAdd

Before installation useshould close all office applications, as because it may cause some conflict during
installation.

4.1 INSTALLING THE ADD-IN FROM DAISYADDINFORWORDSETUP.EXE

Step: 1 Click on thBaisyAddinForWordSetup.exe

File installation will start and user will be presentedindow as shown below, which says welcome to DAISY
Translator setup wizard, giving users option to either Cancel or choose next.
Click on Next button or just hit Enter.

ji Daisy Translator Addin version 2.1.1.0 Setup o ]

Welcome to the Daisy Translator Addin
version 2.1.1.0 Setup Wizard

M' The Setup Wizard allows to change the way Daisy Translaktor

addin wersion 2.1.1.0 Features are installed on waour
computer or to remove it From your computer, Click Mext to
. ¥ conkinue or Cancel ko exit the Setup Wizard.

daisy

COSOE T
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Step 2: Now user will be presented a window as shown below, vehiohs dicense Agreemeét ®

In this stepuser needo select the checkbok L I OOSLJi G KS G S NI &ant it entekKd cligkA O S
on Next button.

ji Daisy Translator Addin version 2.1.1.0 Setup o ]
End-User License Agreement daity
Please read the Fallowing license agreement carefully PR
Microsoft

Copyright (c) 2009, Sanata, DalsyY, Microsoft -

Al rights reserved.

Redistribution and use in source and binary forms, with or without
modification, are permitted provided that the following conditions are met:

* Redistributions of source code must retain the above copyright
notice, this list of conditions and the following disclaimer.
Redistributions in binary form must reproduce the above copyright
notice, this list of conditions and the following disclaimer in the

documentation andyor other materials provided with the
distribution. |

V¥ 1 accept the terms in the License Agresment:

Print Back. I Mk I Zancel

dmr SONATA
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Step3: In this step user should select an installattmopeand hit enter @ click on Next button.

i'e!:I‘ Daisy Translator Addin version 2.1.1.0 Setup ;lglil
i e S AT
Installation Scope S W
Choose the installation scope BRI
Microsoft

Daisy Translator Addin version 2, 1.1.0 will be installed in a per-user Folder and be
available just For vour user account, You do not need local Administrator privileges.

= Install for all users of this machine

Daisy Translator Addin version 2,1, 1.0 will be installed in a per-machine folder by
defaulk and be available For all users. ¥ou can change the default installation
folder, ou must have local Administrator privileges.

Back I Mexk I Cancel |

{GSLI nY b2g dzaSNJ gAff 0SS LINBASYGSR || 6AYyR2¢ | a &Kk
Hit enter or click on Next buttorlsers are given option torowsefor folder either by hitting orchangebutton or
by enterng (Alt +O on the keyboard.

dm SONATA
= TINLNIT
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i'._w!,'J Daisy Translator Addin version 2.1.1.0 Setup - |EI|5|
Destination Folder —
-— Ay

i

Click Mext ta install ko the default folder or click Change ko choose another
Microsoft

Inskall Daisy Translator Addin version 2.1.1.0 ka:

IC:'I,F‘rn:ngram Files!SonatalDAISY Translator 2.1,1.0),

Change... |

Back
Step5Y b2¢ dzaSNJ gAff 06S LINBaASYiGSR | oAYR2¢6 | & akKz2gy
on Installbutton.
- SONATY
@
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{ii Daisy Translator Addin version 2.1.1.0 Setup . o [m] S
e

Ready to install Daisy Translator Addin version 2.1.1.0 -

Click Inskall ko begin the installation. Click Back ko review or change any of waour
installation settings. Click Cancel bo exit the wizard,

P Install Cancel |

Step6: Now a progress window appears showing the progress of the installation.

m SONATA
= TINLNIT
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{ii Daisy Translator Addin version 2.1.1.0 Setup

=101 x]

—~ S

Installing Daisy Translator Addin yersion 2.1.1.0

axd
= AT

Please wait while the Setup Wizard installs Daisy Translatar Addin version 2.1.1.0,

Status:  Copying new files

Back | [ |

Step7b 2% dzaSNJ gAff 0S LINBaSyaSR
with an option to open the Help filédit Enter or click on Finish button.

m SONATA
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{ii Daisy Translator Addin version 2.1.1.0 Setup o [m] S

Completed the Daisy Translator
Addin version 2.1.1.0 Setup Wizard

lick. the Finish button to exit the Setup Wizard

Zancel |

v show Help Back

. @ aStSOGAy3a GKS dpénk@pdelpl filSdigindginsttuttdng ényhatallingkABldiand converting
word documents to Daisy format.

ﬂ:ar SONATA
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=10l x|

Hide Locate  EBack  Fomward  Stop Refresh Home Frint  Options

Cortens | inder | search| Introduction:

|__—_||:[’:_f| Athoring Guidelines -
Introduction
----- a Features
..... =] UDmetadsata

----- a Tables

----- a Images

----- a Captions

----- a Motes and Mote References

----- a Paragraph

..... =] Lists

----- a Levels and Headings

----- a BlockGwotes

----- a Abbreviations and Acronyms

..... a Page Mumbers

..... =] Sidehar

----- £] Table of Contents

----- a Track Changes

----- a Custom Styles

..... ] MathhL

..... ] Muttiple OOXML

----- a Language Detection

----- a Shapes and Ohjects s
..... £] Full &udio Support

Eﬂ--@ Instruction Manual LI

This document provides guidance on how to create an Office
Word document to minimize the fidelity losses while
translating to DAISY xml.

4.2 CONFIRMATION PROCEDURE AFTER INSTALLATION IS COMPLETE.

After the set up is complete user can confirm that the installation is successful by following the stepsetfiven
¢ Open a new word document.
e /TAO1l 2y hTFTFAOS odzidizy 2NJ KAG a!fibCé
e OyadaNBE a{l @S 'a 5! L{,¢ FLIWSIFIENE Ay GKS YSydzo

=
& I
Microsoft
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5 SAvVE As DAISY FEATURES

After successful installation of the Adlduser should follow the following steps.

Stepl:Click on office buttorfTop left hand corner of the Word 2007 user interface) or hit Alt+F
Step2{ St SOG a{ @S +ta 5! L{, YSydz 2NJI1AG 6!'fG bBCO b

5

It will show four sub menus, as shown below

@ H9-v )+ Document2 - Microsoft Word - X

W View Developer Add-Ins Accessibility @
B Jorbmiy i o807 Py
v 2l 2 | B |AaBbCeDe|| AaBbCeDe AaBbCi AaBbCc 43, Replace
~ t=~ v B T MNormal | NoSpaci.. Headingl Heading2 - Change
.7 Qpen y Full DAISY (from single docx) = |Q- = | P g g T Styles T || ki Select T
=~ Full text and full audio in MP3 4 ph (F] Styles F] Editing

bl = . :
| DAISY XML (from Multiple doox)

- Wil DAISY XML only (dtbook did)

ﬂ Save As ]

1 Full DAISY (from Multiple doox)
7 Full text and full audio in MP3 4

@ Prepare 3
E Send 3

EéE'f" Publish »

I_T Close

[ 13 word options | [ X Exit wora

Pageilofl | Wordsi0 | <& | & | | SR = =

1. DAISYXML (from SingledocX):¢ KA & &dzo YSydz gAfft GNYVEAIFIGS] 92 RR
2. FullDAISYftom SingledocX): ¢ KA & &dzo YSydz ¢ ADARYPp&igedd S| NN diao2 NES yix
GNIyatlrdiS 62NR wnnt G2 a5!'L{, 5¢.221¢®
3. DAISYXML (from Multiple docX): This sub menu will translate a group of documents into a siydSY
XML format.

Pagel5
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4. FullDAISYftom Multiple docX): ¢ KA & & dzo Y Sy dz ¢ ADAKYPip&idedTSNarrdtalzé K X 61
gAft GNIXyatrdS 3INRdzZ) 2F R20dzySyda G2 as5!'L{, 5¢

5.1 CONVERTING WORD 2007 DOCUMENT IN TO DAISY XML FORMAT

To convert word2007 to D&Y XML format, user should follow the steps below.

Step 1: Open a document that needs to be translated into DAISY XML Format.

Step2: Ensure that document is saved before proceeding with the translation.

Step3: Click on office button (Top left hand cornethe Word 2007 user interface) or I{ilt + F)

{GSLI nyY /EAO1l 2y G{I @S a 5! L{, odzid2yé¢ 2NJ I AG o!

@2 HY-8 ) Document? - Microsoft Word -aXx
[\ View Developer Add-Ins | Accessibility | @
D New @ DAISY XML (from Single docx) |
- | DAISY XML only [dtbook dtd) | E Q % x
= AddFootnote || Language Settings Wersion Translator
/a7 COpen y Full DAISY (from single docx) Details Help
= Full text and full audio in MP3 * || hes|| AddFootnote || Language || DAISY Settings Help

o = . 2
Q DAISY XML (from Multiple docx)
w12

" DAISY XML only (dtbook dtd]
& Save As 3

é Save As DAISY » |
@ Frint 3
@ Prepara ]
IE Send 3

éE/ Publish »

Full DAISY (from Multiple doox)
- Full text and full audio in MP3 4

I_I" Close

[Q Waord Options ] [X Exit Word

Page:1ofl | Words:0 | & | I | EEIR| =
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Step 5: If the document is a master sub document (current document having sub documents), the following dial
box will be displayed to theser.

DAISY Translator |

L
L1 ) Do ol wank ko branslake the current document along with sub dacuments?

hy Of AO1 2F G, Saé¢ odziti2zyr GKS GNIyatlrdAazy LINROSaa
sub documents included in iDtherwise, it translates the current document excluding its sub documents. Before
showing the Tranation form, the user is presented with an Initializing Translation form as shown below.

a
i
[
5
G

BVT.docx - Microsoft Ward = Ehe

=14 ————

~ | Home ‘ Insert Page Layout References Mailings Review View Accessibility @

=) ibri = By | e | o ||| = s =|(A1][ ] 5 & Find ~

U " Calibri (Body} u - x|B = s E| ﬂ”i‘ AaBbCcDr AaBbCc | AaBbCcDe | AaBbCe % peplace

- e - “ac

Past = 2 a2+ A== i Ch ‘

aste 7 B 1 U - abe x, X A‘,ll,‘g’, A 1 =EE ]LQ 1 Definitio... T Div(DAISY} | 7 Normal | Definition... — Sty?:sgf [y Select~ ‘
||Clipboard {F] Font T

Paragraph = Styles

TULHANEE LI UVEIail IUUA U yUUT WULUTIISTIL LHIUUST HIEW TS Sicineliiuiitic rage Layuut taw. 1o
change the looks available in the Quick Style gallery, use the Change Current Quick Style Set command.
Boththe Themes gallery and the Quick Styles gallery provide reset commands so that you can always
restore the look of your document to the original contained in your currenttemplate.

| Editing |

Emp Number Emp Name
100 John
Jimmy

Initializing Translation. Please wait...

Figure1

Page:1ofl | Words:210 | <& |
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Step 6: Now user is presented with a Translation form as shown below.

)| H -8 |- Doc2.docx - Microsoft Word ST
o

Home Insert Page Layout References Mailings Review View Developer Add-Ins | Accessibility | @

S 8 3 s @ B & X 4N

SavelsDAISY Mark As Manage Mark As Manage || Validate Import AddFootnote | Language Settings Version Translator
- Abbreviation Abbreviation || Acronym Acronym Details Help

Save As DAISY Abbreviations Acronyms Validate | DAISY Styles | AddFootnote || Language || DAISY Settings Help

DAISY Translator x|

Destinatign;|c:\Documents and Settings\pa\.-'an.l-| Brose,., |

Onthe Inserttab, the gal
your document. You can

the overall look of
coverpages,and
ey also coordinate

Document propertie
otherdocumentbuilding Rt

selected textfromthe Qi
the othercontrols on the | Uid: |54?5?15602621449261
theme orusinga format’

ext directly by using
from the current

. Title: |Ec0n0mics |
with your current docum
Creataor: |pa\.ran.k\.r |
You can easily change the . osing a look for the
Publisher: |ss| |

W Reset e I E Page Layouttab. To

change the looks available in the Quick Style gallery, use the Change Current Quick Style Set command.
Both the Themes gallery and the Quick Styles gallery provide reset commands so that you can always
restore the look of your document to the original containedin your currenttemplate.

To change the overalllog

Page:1of1 | Words: 185 | gﬁ | E | | e =)

Translator form contains fields such as Destination, Document Title, Document creatam&u Publisher,
Document UID; all these fields will be auto populated from the document propentiegify or change these
@l fdzSa AF NBIJIdZANBR YR (KSy OftA01] 2y aG¢NIyafl

[@=tN
(V)
™~

Note: Keyboard users can navigahrough the form using following options:
e Destination Field (Alt +D)
e Browse (Alt + B) to browse for destination folder.
o Title (Alt +1)
e Creator (Alt +C)
e Publisher (Alt +P)
e UID (Alt +U).
e Translate (Alt +T)
e Reset (Alt +R) to reset all the field values.

—
& hn
e

Aelinita W Tmaki

Microsoft
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7

9GS cY hy OftAOl 2F AG¢N}yatld8é odaitizys t NEaINBaa o

Oa) LD =) - BVT.docx - Microsoft Word Drawing Tools = Fhas
\JEE =
[ Home l Insert Page Layout References Mailings Review View Accessibility Format

= . P 8 P | e | [ ||| [ e e A 3 Find ~

| B E2libl By u_~ ||| fEE (B[] azsbcen AaBbCc Aasbcede AaBbCt %
‘ i Aa| (257 ‘ ; : croenis. T DHDALS o ‘
‘ Rt B £ U~ abex x Aa|2 Avj; =-|[Sx =i o] ||| 7 Derinitio... 7DVDAISY || T Nommal | Definition... | gthyalgsof | It sebect= |
|Clipboard 1 | Font | Parag | Styles /|| Editing |

TuLnange uic uveian n.:ul\ Ul YU GULGHTIE G LHUUSE e 1 l"l:;rlre TSNS Ul UIE Fage LayuutL taw. 1o
change the looks available in the Quick Style gallery, use the Change Current Quick Style Set command.
Both the Themes gallery and the Quick Styles gallery provide reset commands so that you can always
restore the look of your document to the original contained in your currenttemplate.

Emp Number Emp Name
100 John
110 Jimmy

Translating to DAISY... }

Figure 1

Page:1of1 | Words:210 | <& | | =2

Step 7: After successful translation a success message is given to the user. Click on Ok or press enter.

Pagel9



Open XML to DAISY XML Translator Instructions Guide

H9-0 s BVT.docx - Microsoft Word =
[ Home l Insert Page Layout References Mailings Review View Accessibility

= o T I | [ ||| e e | o - &4 Find ~
= " coton oy ‘o -[aw|B) [EE [BU[] aspocen: AaBbCC |AaBoccDc| AaBbCc I
“ac
1 Normal

Paste j 1|B I U - abe x, X' Aa-|[®- A - ;|§1’§ = =([{=-|(&~ & || 10efinitio... 10WDAISH Definition... ~ Change |

‘ |
\ ‘ Styles~ || b Select = 1
|Clipboard ™ || Font £ Paragraph )| Styles %/ Editing |
TULHANEES LIS UVEI G IUUA UT yUUT WULUWHIENIG LSS HIEW THEHIE SISinS i Ui UIE Fage Layuut taw. 1o g -
change the looks available in the Quick Style gallery, use the Change Current Quick Style Set command.

Boththe Themes gallery and the Quick Styles gallery provide reset commands so that you can always

restore the look of your document to the original contained in your currenttemplate.

Emp Number Emp Name
100 John
110 Jimmy

DAISY Translator - Success x|

.
\ 1 ) Successfully Translated the document.

Page:1of1 | Words:210 | <& |

Step 8: If the translation is soessful and if there were some fidelity loses, Fidelity lose dialog box will be provide
with fidelity losses that occurred during translation.

o T
g LI

tatehte
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D\ d9-0 )¢ BVT.dack - Micrasaft Ward Text Box Tools = e
- 7\ Home ‘ Insert Page Layout References Mailings Review View Accessibility Format
=% : : = A (@) = = = . 33 Find ~
e e SN BN =R |E AaBbceDc | AaBbCe¢ % e
e — A Sac
Paste B 7 U ~abe x, % Aa~|[®¥~ A~ 7 Definitio... T Div(DAISY} | T Normal | Definition... - Change
= 4 l = X “ A } l (DAISY) 7 Styles~ || W Select~ |
||Clipboard ™ Font iF Paragraph ] Styles iF] Editing 1

DAISY Translator - Fidelity Loss 3 A
The following elements are lost during translation,
Summary:

i Cover Page is not translated More Info

LCopyto Log file Cancel I

Mahesh

Page:1 of 2 | Words: 1/220 | <3 |

| @LISNI AYy |1 SKAOK alea a/ 2Lk
loss messages at the location specified by the user.

{ ONBSy &aK2i( l02@0S &aK2ga (GKS CARS
G2 |

Ly OF&$S 27¥F & al,#dn8rivd odcdmuhilearBldnvighyidaster dcumenta 51 A & & ¢ NI y &
£+ £ ARFGA2Y SNNRiN#ayeRtb thd LBed with it ddcdnierits afidSerror occurred in
respective documerst

Page21
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D) d9-0
o)

41
Q
@
Q

docx - Microsoft Word =

[7 Home ‘ Insert Page Layout References Mailings Review View Developer Add-Ins Accessibility
| % ibri = B e | oo ||| e e = | el (A ][ a7 s A & Find -
| B £alibt Bdcy u -[aw|®|EE E|lvw w24 7] | AaBbCcD¢ | AaBbceD: AaBbCi B nohi
=2 | | “ac
‘ Paste ¥ ‘l j : BT 308 1 ERAE T R Aa'“a??' A') ‘|§1§ = 5" zg']'g '( ‘ Normal |17 NoSpaci.. Headingl - Change |
| 7 | | =
|Clipboard | Font || Paragraph | Styles || Editing

[ Styles~ || Le Select - |

DAISY Translator x|

OntheInserttab, the g 7 . e overall look of
Translation failed.

yourdocument. You ca |validation error found while translating the following over pages, and

other document buildif [documents. y also coordinate

withyour current docu | vpyT docy”

; \Validation error: ’
You can easily changet [an error occurred during a call to extension function 'Book’, See  |iNga look for the

selected textfromthe |InnerException for a complete description of the error. tdirectly by using
the othercontrolson tl om the current
theme orusinga form:

To change the overalll¢ age Layouttab. To
change the looks availa tyle Set command.
Both the Themes galler Click here for Authoring Guidelines t you can always
restore the look of you SaveTolLogFile ﬂl E.

Page:10f1 | Words:185 | <6 English (US) | P | | EEE

G5FAae gNIFfyRRHGRNY SNNBNE G6AYR26 LINE dideim&doctimeéntaidnli A ;
and also an option to save the log fildich ishaving the information about validation errors that occurred during
the translation.

daisy
e O TDITIITT

tatehte
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Do\ H9-0 )+ BVT.dacx - Microsoft Word = s
) e
= Home ‘ Insert \ Page Layout References Mailings Review View Accessibility @
|£) Cover Page ~ " Elgl @ g 2, Hyperlink E'Ej ‘ =3 B |2 Quick Parts » |2 Signature Line ~ | TT Equation ~
] Blank Page Hy &= A& Bookmark = = = dWordArt w 3 Date & Time £2 Symbol ~
= Table Picture Clip Shapes SmartArt Chart Header Footer Page Text = "
¥= Page Break v Art v ' Cross-reference - >  Number~ || Boxr 2=DropCap- g Object ~
Pages Tables Nlustrations Links Header & Footer Text Symbols |
- i)
x
Translation failed, and translated document is invalid.
Summary:
Line Number: 24 and Line Position : 8
L) Message : The element 'levell’ has incomplete content, List of possible eleme
El P! p
Reference Text:
| — i
Click hef hoting Guideli
Save To Log File M
Mahesh

Page:1of2 | Words:220 | <& | EEEE

5.2 CONVERTING WORD 2007 DOCUMENT IN TO DAISY DTBoOK
To convert word2007 to DAISY DTBook, useunlghollow the steps below.

Step 1:0pen a document that needs to be translated into DAISY DTBook.

Step2 Ensure that document is saved before proceeding with the translation.

Step3:Click on office button (Top left hand corner of the Word 2007 userfixte) or hit Alt+F

Step 4/ f A O KWBAISKfYm Singledocyé 2 NJ LINBYaNl 038 dzol BXISYPrliteTdS NNI § 2 |
gAff 0SS &aKRAMSYRpelindTASNarrdtarya dedo YSy d)+eeAkDI A G 6! f b C
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@ -0 ) Doc2.docx - Microsoft Word =E
] View Developer Add-Ins | Accessibility | @
D . @ DAISY XML (from Single docx) |
= ~ DAISY XML only [dtbook dtd) E Q >€ ﬁ &
L] AdEactant Settings Version Translator
7 Open y Full DAISY (from single docx) | QAIS\‘PlpehneTFSNanatol Details Help
| é Full text and full audio in MP3. * iTes Gotnote || Language || DAISY Settings Help ]
H Save 5 {9 DAISY Addin Word 2007 o
1 DAISY XML (from Multiple docx) Press F1 for more help,
“| DAISY XML only [dtbook dtd)
ﬂ Save As 3

1 Full DAISY (from Multiple doox)
7 Full text and full audio in MP3 4

$ Save As DAISY » |

s thatare designed to coordinate with the overall look of
Print 3 to inserttables, headers, footers, lists, cover pages, and
create pictures, charts, or diagrams, they also coordinate

Prepare 3

:cted textinthe documenttextby choosing a look for the
n the Home tab. You can also format text directly by using
ontrols offera choice of using the look from the current

H ;-‘ Publish ] ectly.

I_T Close t, choose new Theme elements on the Page Layout tab. To

= gallery, use the Change Current Quick Style Set command.
| |23 word Options | |)( Exit Word | 25 gallery provide reset commands so that you can always

restore the look of your documenttothe original contained in your current template.

e g

Send 3

Page:10f1l | Words:185 | <% | 5 | | /&

Step 5: If the document is a mastrb document (current document having sub documents), the following dialog
box will be displayed to the user.

DAISY Translator |

L
L1 ) Do ol wank ko branslake the current document along with sub dacuments?

hy Of AO1 2F &, Saé¢ odzitz2ysz GKS GNIyatlrdAzy LINROSaa
sub documents included i Otherwise, it translates the current document excluding its sub documBetare
showing the Translation form, the user is presented with an Initializing Translation form as shown below.
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Cla ‘ﬂ Dalds) + BVT.docx - Microseft Word = X
L)

| Home | Insert Page Layout References Mailings Review View Accessibility

= e I ol - &4 Find ~
e i\ Calibri (Boch) " A& w|Z] == E BT assscen AaBoCc |assbccoc| AaBbCC -
1 Normal

el ‘.h Repl |
; e [[B 2 U~ abe % 3 Aa-||#-~ A'” = [EERES -| || 7 Definitio... 7 Dv(DAISY Definition... | Change || = i
I | g

2 Styles~ || b Select =
Paragraph | Styles % Editing

i

|Clipboard || Font | |

TULHAIHEE LIS UVEIaN IUUA UI UL GULUIHIETIL UHIUUSE HIEW HHEHIE SIENISN Ul UIE Fage LayuuL taw. 1u
change the looks available in the Quick Style gallery, use the Change Current Quick Style Set command.
Both the Themes gallery and the Quick Styles gallery provide reset commands so that you can always
restore the look of your document to the original contained in your currenttemplate.

Emp Number Emp Name
100 John
110 Jimmy

Initializing Translation. Please wait...

Page:1ofl | Words:210 | <& |

Step 6: Now user is presented with a Translation form asveHhmelow.
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H 9D-4 ) Doc2.doox - Microsoft Word - =

Home Insert Page Layout References Mailings Review View Developer Add-Ins | Accessibility | @

Q4 8 g s @ B & X 4N

SavehsDAISY Mark As Manage Mark As Manage || Validate Import AddFootnote | Language Settings Version Translator

- Abbreviation Abbreviation || Acronym Acronym Details Help
Save As DAISY Abbreviations Acronyms Validate | DAISY Styles | AddFootnote || Language || DAISY Settings Help |
i
ﬂ
Onthe Inserttab, the gal ) - Il look of
! g Cutput directory IC:\Documents and Settingshpavanbks  Browse., |
your document. You can bes,and
otherdocumentbuilding S ordinate
with your current docum | .. |Economics |
You can easily change the | Creator: |pa\.-'an.k\.-' | k for the
selected textfromthe Qi Publisher: |SS| | fy by using
the other contrals on the current
theme or usinga format | Jidk |485?05?3?1208996163 |
Tochange the overalllog Show Advanced > » | Translate I Reset Cancel | outtah.To
change the looks availabl T command.

Both the Themes gallery and the Quick Styles gallery provide reset commands 50 that you can always
restore the look of your document to the original containedin your currenttemplate.

Page:1of1 | Words:185 | <% | B | | IS

Translator form contains fields such as Output directory, Document Title, Document creator, Document Publishi
Document UID; all these fields will be auto populated from the document propentiegify or change these
values if required. ABY G KS FT2NX gAff KIFGBS a{K2g ! ROlFIyOSé¢ o0 dzii
expand the form as shown below.

The 'Show Advancédform contains the following fields:
1. DTBook Fix (drogown list)
Selects whether to apply DTBook Fix routineghinput document. These routines try to clean and

possibly repair the input DAISY XML document to enforce the best compatibility with the remaining step
The "Apply DTBook Fix routines" option is recommended.
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2. Apply sentence detection (cheeliox)
Selets whether to apply sentence detection to the input document text to enable a-fijnained audio
synchronization.

3. MP3 Bitrate (dropdown list)
Selects the bit rate of the generated MP3 audio files. A higher value will result in better sound quality bu
the audio files will be larger. The default value is 32 kbit/s.

4. 2.02 href target (dropdown list)
Selects the SMIL element (text or par) to target by href URIs in the content document and navigation
control file of the generated DAISY DTB. "text" isdéfault value but some DAISY players will behave
more gracefully if "par" is selected.

Cln H®w-uv s Doc2.doc - Microsoft Word = 5 X
Toa) o e —
~ Home Insert Page Layout References Mailings Review View Developer Add-Ins | Accessibility | @
A abbr abbr H
L 8d g Y B & X N
SavehsDAISY Mark As Manage Mark As Manage | Validate Import AddFootnote | Language Settings Version Translator
= Abbreviation Abbreviation || Acronym Acronym Details Help
Save As DAISY Abbreviations Acronyms Validate | DAISY Styles | AddFootnote || Language || DAISY Settings Help |
i)
DAISYPipelineTTSNarrator ﬂ
Onthe Inserttab, the gal ) - Il look of
! g Output directary IC:\Documents and Settingsipavanlks  Browse., |
your document. You can pes, and
otherdocument building ) ordinate
Document propertie
with your current docum | 1. |Ec0n0mics| |
You can easily change the | Creator: |pa\.-'an.k\.-' | k for the
selected textfromthe Qi | o iy |ss| | fy by using
the other contrals on the current
theme or usinga format | Jidk |48539143?9946686420 |
To change the overallloo J outtab.To
r DTBook Fix |&pply DTBook Fix routines A
change the looks availabl I PEY command.
Both the Themesgallery ¥ Apply sentence detection n always
restore the look of your ¢ rAP3 Bitrate |32 khit/s j
< <Hide Advanced | Translate I Reset Cancel |
Page:1ofl | Words:185 | <4 | B3 | | ElEEEY

hy Of AO1 2F G¢NIyatliSé odzihz2y thetraasjationIpdcess wif Sartl £

Page27



Open XML to DAISY XML Translator Instructions Guide

Note: Keyboard users can navigate through the farsmg following options:
¢ Browse (Alt + B) to browse for destination folder.
o Title (Alt +I)
e Creator (Alt +C)
e Publisher (Alt +P)
e UID (Alt +U).
e Translate (Alt +T)
o Reset (Alt +R) to reset all the field values.
e Show Advanced (Alt + V)
¢ Hide Advanced (Alt + H)

7

{GSLI TY hy OftA0] 2F G¢NIyatlisSé odziti2zy>s t NPINBaa

Do)\ H9-0 )+ BVT.docx - Microsoft Ward Drawing Tools =
(7 eem—

[ Haome ‘ Insert Page Layout References Mailings Review View Accessibility Format
& ibri - A A l[®8] 5= - = = (= == |3 1] [ o] - % 3 Find ~ 1
B, | EEED u -|a | |= || #&{[34][%7]|| AspbceD: AaBbCC Asoccoc AaBbCc el

= = A : || - e e 2 oA |
£ S R RN |- oo o oo (S
||Clipboard ™ Font ] Paragraph | Styles IE] Editing |

TULHAINEE LIS UVEI G IUUA UT y UL LULUITIE TG LHIUUSE HIEW THEHIE EIEINENIL Ul LIS Fage LayuuL taw. 1u &
change the looks available in the Quick Style gallery, use the Change Current Quick Style Set command.
Boththe Themes gallery and the Quick Styles gallery provide reset commands so that you can always

restore the look of your document to the original contained in your currenttemplate.

Emp Number Emp Name
100 John
Jimmy

Figure 1

Page:1oft | Words:210 | <& | =

{GSLI yY ! FGSNI O2YLX SGAy3I mnrx: GKS tNRaINB&aa o6 NJ g4
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Q - VT.docx - Micrasoft Word =S
Home ‘ Insert { Page Layout References Mailings Review View Accessibility

% (2l Quick Parts ~ |2 Signature Line ~ | JT Equation ~
= :

— 4 wordart~ (3} Date & Time €2 Symbol ~

|£) Cover Page ~ - Elgl @ T ﬂ &, Hyperlink
| ] Blank Page - M Bl 4 Bookmark

=

= Table Picture Clip Shapes SmartArt Chart \‘ Header Footer Page A "
‘ ¥= Page Break ‘ - | Art - | 'A) Cross-reference ||+ v Numberv || Boxv 2=DropCap~ g Object ~
| Pages | Tables | Tllustrations { Links | Header & Footer | Text | Symbols

Build Verification Testing

Translating to DAISY... r 1
Thisis a simple documentf ...

Onthelnserttab, the galle Initiating audio file g ion.Please wait... h the overall look of
your document. You can ug ts, cover pages, and
they also coordinate

otherdocumentbuildingb
withyour current documentiook.

You can easily change the formatting of selected textin the document text by choosing a look for the
selected text fromType equation here. the Quick Styles gallery on the Home tab. You can also format
text directly by using the other controls on the Home tab. Most controls offera choice of using the look
fromthe currenttheme orusing a format that you specify directly.

—b +b2—dac

# 2a

To change the overalllook of your document, choose new Theme elements on the Page Layouttab. To
change the looks available in the Quick Style gallery, use the Change Current Quick Style Set command.
Both the Themes gallery and the Quick Styles gallery provide reset commands so that you can always
restore the look of your document to the original containedin your current template.

[ Emp Number Emp Name

Page:1of1 | Words:210 | <& | EEE

Step 9: When the "Transiag to DAISY" step is completed, the Pipeline Lite tool starts the DAISY XML to DAISY
DTBoktranslation and the user is presented with the "Pipeline Job Progress" dialog.
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-8 )= Doc2.doox - Microsoft Word - =
'. In_
| Home | Insert Page Layout References Mailings Review View Developer Add-Ins Accessibility @
P Find ~
% # | Calibri (Boay) - aIrSNIEIE % o
B - 2l Replace
Paste = Ej A _ (Change
= . | B 7 U abe %, X' Aa~ || | THormal | TNoSpaci.. Headingl Heading2 — Styles s Select ~
Clipboard {F] Font Ta Paragraph s Styles E} Editing

Onthe Inserttab the aallariac inclida tame that ara dacirnad tn ranrdinata with tha ruargl] logk of

your document Pipeline Job Progress zes, and
otherdocumen i) Running DAISY Pipeline TTS Marratar. .. bordinate
with your curre
You can easily ¢ ML Detection [7/12] ok for the
selected textfr Iy by using
the othercontn current

|
theme orusing

To change the overalllook of your document, choose new Theme elements on the Page Layouttab. To
change the looks available in the Quick Style gallery, use the Change Current Quick Style Set command.
Both the Themes gallery and the Quick Styles gallery provide reset commands so that you can always
restore the look of your document to the original containedin your currenttemplate.

Page: 52 of 129 | Waords: 185 | gﬁ | E | | EE IR E|

Stepl0: A progress bar shows the progress of the translation and a label (be¢oprogress bar) shows the name
of the currently running step.

7

b2iS GKIG GKS GNIyatldrazy Attt GF1S aSOSNIf YAy dz

Step 11: A "Cancel" button allows the user to prematurely abort the translatiote. that the Pipeline Lite
process might not terminate immediately but wait for the current task to complete. Some temporary files may
then be left in the output directory.

Step 2: When the translation completes successfully, the user is shown a "Pigelin€ompleted” dialog box
displaying the message "Job Completed".
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Cla ‘H 9-=48.) ¥ VT.doox - Microseft Word — X
Home ‘ Insert [ Page Layout References Mailings Review View Accessibility @

[ Cover Page ~ | ‘ El@l @ ﬁ 8, Hyperlink = =t 2] Quick Parts ~ |2 Signature Line ~ | JT Equation ~

|] Blank Page I e “ e i 1 A Bookmark | # A wordart -~ (5} Date & Time £2 Symbol ~ ‘

= Table Picture Clip Shapes SmartArt Chart | Header Footer Page | Text A= . |

¥= Page Break ‘ Art - || ') Cross-reference - ~  Numberv || Boxv 2=DropCap~ g Object ~ |

Pages \ ‘ Tables || Tlustrations ‘ | Links ‘7

Header & Footer [ | symbols |

Pipeline Job Progress
® Pipeline Job Completed _)g

\i) Job completed.

Build Veri

Thisis a simpl

Onthelnsert: -_JE HELED rall look of

ourdocumer ages, and
Y g

otherdocument building blocks. When you create pictures, charts, or diagrams, they also coordinate
with your current documentlook.

You can easily change the formatting of selected textin the documenttext by choosing a look for the
selected text fromType equation here. the Quick Styles gallery on the Home tab. You can also format
text directly by using the other controls on the Home tab. Most controls offera choice of usingthe look
fromthe currenttheme orusing a format that you specify directly.

—b +b2—4ac

= 2a

To change the overalllook of your document, choose new Theme elements on the Page Layouttab. To
change the looks available in the Quick Style gallery, use the Change Current Quick Style Set command.
Both the Themes gallery and the Quick Styles gallery provide reset commands so that you can always
restore the look of your document to the original containedin your currenttemplate.

Page:1of1 | Words:210 | <& |

Onclickof the "Details" button, the dialog expands and the user is presented the list of Pipeline messages
produced during the translation process.

§
e LLLILUID
Aelinita W Tmaki

Page31



Open XML to DAISY XML Translator Instructions Guide

Ca ‘E -4 Z Daisy,docx - Microsoft Waord - REX
- | Home ‘ Insert Page Layout References Mailings Review View Developer Add-Ins Accessibility
=2 N} g = e El e I . 3 Find ~
(e Calibri (Body) 1~ | ED]|E=E v w249 \AaBbCcDC | AaBbCcDe AaBbCi % oo

=F — “ac

Pavste 7 |B 7 U~ abe x, X A‘.“a??~ A" == fNormal |7 NoSpaci.. Headingl - g:‘ya.:‘sgf I Select =

||Clipboard ™ Font T Paragraph

] Styles IF] Editing |
i)
Onthe Inserttah tha aallariacincluds fame that ara dacianad tn ranrdinata with tha nvars|| look of
yourdocument Pipeline Job Progress ges, and
PTG IYItoEtl)  Pipeline Job Completed Xl ordinate
with your currei i ) Job completed.
You can easily ¢ ok for the
selected text fri 1 [INFO] XSLT message: Added a dummy ht ly by using
the othercontri i [INFO] Mo errors or warnings reported. Congratulations! current
theme or using i [INFO] Yalidating with Zedval version 2.1 beta 4
4 i [INFO] Mo errors or warnings reported. Congratulations!
To change the o' i [INFO] No errors or warnings reported. Congratulations! lyouttab. To
change the look: t command.
Boththe Theme an always
restore the look oK I
Page:1ofl | Words:0 | G English(us) | &3 | | E8E

The output directory will cotain both a DAISY 2.02 DTB and DAISY 3 DTB (Z8936sharing the same audio
files.

Note that on some cases dummy headings may be added to the document to conform to the DAISY specificatic
(this happens for instance when no heading were found iriiee input document).

Press the "OK" button to return to the Microsoft Word document.

Step 13When errors occurred during the translation, the user will be shown a "Pipeline Job Failed" dialog box
displaying the message indicating the detailed stdyere the translation failed.
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Q b o )~ Anchor_3.doox - Microsoft Word - 8 X
-.n._
| Home | Insert Page Layout References Mailings Review View MathType Add-Ins Accessibility @
=k

_] 5 Calibri [Body) .

]
Paste |BIUvduxan||EJ_vé|

&3 Find ~
.- AaBbC AaBbCc | aaBbCeDc | AaBbCcDe %
T Marmal

2 Replace
_ Change
Heading 2 Heading 3 T Mo Spaci.. - tylesg' [y select -

Clipboard E} Font {F] Paragraph {F Styles {F Editing

Anchor having anavtarnalrafaranre farhaainninanfthe avtarnaldacimant
Pipeline Job Progress

# Pipeline Job Failed x|
Your Logir 8 Unexpected Errar,
Your Univers bgin name
is also called i [INFO] Document was malfarmed,
v, b i [INFO] Document was malformed,

oucan acf v i [INFO] Document was malformed, - own
computer or_ i [INFO] Document was malformed,

. 0 [ERR.OR] Saving the result to An error occured: URI has an authority compone . R
It's best to use 0 [ERR.OR] Unexpected Error. bs in their
proper contex

. . l | |
University
PCsare locate oK | == Details I L by IS5, and
about 700 pros

The PCs provide extremely fast Internet access, a large collection of software, personal
secure filestore. and excellent printing facilities.

Where do | get my Smartcard?

Page:1ofl | Words:135 | ¢ English U.s) | B3 | | =HED|

On press on the "Details" button, the dialog expands and the user is presented the list of Pipeline messages
produced during the translation process.

Refer to the "Troubleshooting” section for further informationwhat to do. Press the "OK" button to return to
the Microsoft Word document.

Step 4: If the translation is successful and if there were some fidelity loses, Fidelity lose dialog box will be provi
with fidelity losses that occurred during translation.

Page33



Open XML to DAISY XML Translator Instructions Guide

- Q l) - U 5 BVT.docx - Microsoft Word Text Box Tools i
29 =S

(O
[ Home ‘ Insert Page Layout References Mailings Review View Accessibility Format

= = A 34 Find ~
) [comoreesangy -3s [ &[] 1=~ 1= - | E B[] numncen. AaBbCc [asmocenc] AsBbCC ;

S t 53 = s &Repla(e
~||387 + = = =l \
aste ¥ l B 7 U ~abe x, X' Aa “ by A ’ |§ = =} HQ ( ‘ 1 Definitio... 7 Div(DAISY} | 7 Normal | Definition... — tyalgsg [ Select >

Clipboard ™ Font iF Paragraph | Styles G| Editing

DAISY Translator - Fidelity Loss ‘)_(]
The following elements are lost during translation,
Summary:

i Cover Page is not translated More Info

LCopyto Log file Cancel I

Mahesh

Page:1 of 2 | Words: 1/220 | <3 | | EEEEE

{ ONBSYy aK2i4 020S aK2ga (GKS CARStAdGe f2aa YvYSaal 3s
I @ LISNI A Y ’K)\GK al éea G/ 2L G2 [23 FTAESé 6KAOK 6A
loss messages ateHocation specified by the user. On clicking OK (press enter) or Cancel a message will be shc
G2 GKS dzaSNX» hy Of AO01Ay3a a, Sad¢ 2NJ LINBaaAiAy3a a9y iSN.

stop.

Page34



Open XML to DAISY XML Translator Instructions Guide

g L R, B BVT.docx - Micrasoft Word SR

"k. | Home I Insert Page Layout References Mailings Review View Developer Add-Ins Accessibility
F‘ﬁ dﬁ Calibri (Body) - R E ':||Hr11u|.[—| AsBbCcD: AaBbCc | AasbCedx| - ?::d,a;,
| Paste 7 |B I U ~aex, X Aav||®- A~ |{;|§ == 1 7 Definitio... 7 Div(DAISY} | T Normal |- g!ya':s‘.lf 1“:&::(-;
|Clipboard '3 Font | | Styles % Editing |

- &

DAISY Translator |

? Do you want to create audio file

[Pick the date]

Mahesh

Page:1of2 | Words:220 | <& English(Us) | B | | EEEEE

Step 16:flan error occursvhile translating thénput Documenta 5 1 A & @  ¢NE fy AR H GRNY S NNR
will be displayed to the user with input document attte error occurred ithe document.So, the Audio files will
not be generated for that document.
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a2
i
&
5
G

BVT.docx - Microsoft Word = e
Home ‘ Insert ‘ Page Layout References Mailings Review View Accessibility
|£) Cover Page ~ | El@l @ 2, Hyperlink Eéj [ :Ej E‘j (2l Quick Parts ~ |2 Signature Line ~ | JT Equation ~
u Blank Page i He =] A& Bookmark | — —2 = - dWordArt w @ Date & Time £2 Symbol ~
= Table Picture Clip Shapes SmartArt Chart || || Header Footer Page 2 A= X
| ¥=PageBreak || - Art v | '8) Cross-reference || >  Number~ || Boxr 2=DropCap- g Object ~
| Pages | Tables | Tllustrations { Links | Header & Footer )1 Text Symbols
- )

DAISY Translator - ¥alidation Error \ 5]

Translation failed, and translated document is invalid.

Summary:

Line Number: 24 and Line Position : 8

) Message : The element 'levell’ has incomplete content, List of possible eleme
Reference Text:

Save To Log File Cancel |

Mahesh

Page:1of2 | Words:220 | <& | EEEEE

Ly OI & SersubFdoduradntié & error occursvhile translating themasterdocumenta 5+ A 8@ ¢ NJ y &

+ £t ARFGA2Y SNNRiNHayeRtb thd Bel with idptit décdnierits afidSerroroccurred in
respective documerst
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I:!n | E )= u X Daisy,docx - Microsoft Word - X
- J Home ‘ Insert Page Layout References Mailings Review View Developer Add-Ins Accessibility
% e T T s = T = z 3 Find ~ ;
i Calibri (Body) -lu - |[Ada 2= = SIRIRTPIE \AaBbCcDc | AaBbCeDc AaBbC |

ﬂk, Replace |

fNormal |17 NoSpaci.. Headingl - Change
B 9 7 Styles~ L Select -

||Clipboard ™ Font iF Paragraph i Styles G| Editing
£
DAISY Translator x|
OntheInserttab, the g Transiation failed. e overall look of
yourdocument. You ca |validation error found while translating the following overpages, and

other document buildil [#ocuments. y also coordinate

withyour current docu | vpyT docy”

; \Validation error: ’
You can easily changet [an error occurred during a call to extension function 'Book’, See  |iNga look for the
selected textfromthe |InnerException for a complete description of the error.

the othercontrolson tl
theme orusinga form:

tdirectly by using
om the current

To change the overalll¢
change the looks availa

age Layouttab. To

tyle Set command.
Both the Themes galler Click here for Authoring Guidelines t you can always
restore the look of you SaveToLogFile ﬂl E.
Page:1of1 | Words:185 | <% English(U.S) | P | EEEEE

G5FA&e gwalidgtie/t ISINNRINE gAYR26 LINPOARSA +y 2LGA2y (2
and also an option to save the log fildich ishaving the information about validation errors that occurred during
the translation.

5.3 CONVERTING MULTIPLE WORD 2007 DOCUMENTS IN TO DAISY XML FORMAT

c2ttz2g GKS 0St2¢ adSLA

(et

2 GNXyatradsS ' 3INRdzI 2F R2

e / f A ODAISYMWL (ftom MultipledocXé & dzo Y Sy dz FNV4INBaa o! fd b
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e Before showing the Translation form, the user is presented aiithnitializing Translation form as
shown below.

-
<& W
Microsoft
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